
ВВЕДЕНИЕ В АКУСТИКУ РЕЧИ. 
ЭКСПЕРИМЕНТАЛЬНО-
ФОНЕТИЧЕСКАЯ ПРОГРАММА “PRAAT”



Акустика

Аку́стика (от греч. ἀκούω ‘слышу’) — наука
о звуке, изучающая физическую природу звука и
проблемы, связанные с его возникновением,
распространением, восприятием и воздействием.

Акустика является одним из
направлений физики, исследующих упругие
колебания и волны от самых низких (условно
от 0 Гц) до высоких частот.



Термин «акустика» был введен в 1701 г.
Жозефом Совёром (фр. Joseph Sauveur, 1653–1716),
французским математиком и акустиком, основателем

музыкальной акустики,

членом Парижской

Академии Наук (1696).



Некоторые направления современной акустики:
• общая (физическая акустика) – теория излучения и

распространения звука в различных средах, теория
дифракции, интерференции и рассеяния звуковых волн;

• геометрическая акустика – законы распространения
звука;

• психоакустика – основные законы слухового восприятия,
определения связи объективных и субъективных
параметров звука, определения законов расшифровки
«звукового образа»;

• музыкальная акустика – проблемы создания,
распространения и восприятия звуков, используемых в
музыке;

• биоакустика – теория восприятия и излучения звука
биологическими объектами, изучение слуховой системы
различных видов животных и др.;

• акустика речи



Звук

Звук – это физическое
явление, представляющее
собой распространение в
виде упругих волн
механических колебаний в
твёрдой, жидкой или
газообразной среде
(вызывающих слуховые
ощущения).



Звук 

• Обычный человек способен слышать звуковые
колебания в диапазоне частот от 16—20 Гц
до 15—20 кГц.

• Ниже диапазона слышимости человека –
инфразвук.

• Выше диапазона слышимости человека –
ультразвук и гиперзвук.



Звуковая волна 



• Длина волны – расстояние между двумя ближайшими
друг к другу точками в пространстве, в которых
колебания происходят в одинаковой фазе.

• Амплитуда – максимальное значение смещения или
изменения переменной величины от среднего значения
при колебательном или волновом движении.

• Частота – физическая величина, характеристика
периодического процесса, равная количеству
повторений или возникновения событий (процессов) в
единицу времени (Гц).



Речевой звук (звук речи) 

• Речевой звук (звук речи) – звук, образуемый
произносительным аппаратом человека с целью
языкового общения (к произносительному
аппарату относятся: глотка, ротовая полость, язык,
лёгкие, носовая полость, губы, зубы).



Разделы общей фонетики как науки о звуковой
стороне речевой коммуникации:

• функциональная фонетика (фонология) – функции и 
системная организация звуковых средств языка;

• артикуляционная фонетика – анатомо-физиологическая
база артикуляции (речевой аппарат) и механизмы
речепроизводства;

• акустическая фонетика – физические характеристики
звуковых средств языка, речевого сигнала (в тесной связи с
артикуляцией и восприятием) – оформилась в отдельную
дисциплину в 1940-е гг.;

• перцептивная фонетика – осуществление слухового
анализа и опознание (идентификация) звуковой оболочки
речевого высказывания и его фонетических составляющих





Акустическая теория речеобразования

• АТР изучает связь между органической фазой
артикуляции и акустическим результатом
артикуляционных процессов.

• Задачи АТР:

- выявить и количественно описать аэродинамические и
акустические процессы, которые происходят в речевом
тракте при артикуляции;

- объяснить и интерпретировать физические речевые
данные.



Основы АТР:

XIX в. – работы
немецкого физика

Г. Ге́льмго́льца 
(1821–1894)

ХХ в. – работы

Гуннара Фанта
(1919-2009)

[Фант 1964] и

Джеймса Л. 
Фланагана
[Фланаган 1968]



Основные положения 
акустической теории речеобразования

движения речевых органов

(не речевой сигнал, а) 

аэродинамические условия в речевом тракте, 

необходимые для образования звуковых колебаний

(подобно кларнету или органу):

- 1) создать поток воздуха;

- 2) «раздробить» этот поток, 

превратить его в колеблющуюся воздушную струю

(наложить на движущийся поток 

акустическое возмущение, модуляцию) 



дыхательная система –

инициатор звуковых колебаний

голосовые связки и преграды в

надгортанной полости 

речевого тракта –

создают акустическое 

возмущение

голосовые связки и

артикуляторы, участвующие 

в образовании шумообразующих

преград, – источники звуки



Изменение акустических характеристик 
«сырого» звукового материала

резонансные (частотно-избирательные, фильтрующие) 
свойства воздуха в речевом тракте:

воздушный столб речевого тракта – колебательная система 
с собственными частотами колебаний

Частотные составляющие в спектре источника:
1) усиливаются (близки собственными частотам реч. тр.);

2) не изменяются;
3) подавляются

специфический тембр звучания



Резонанс
(от лат. resono ’откликаюсь’) — частотно-избирательный отклик
колебательной системы на периодическое внешнее воздействие, который
проявляется в резком увеличении амплитуды стационарных

колебаний при

совпадении

частоты

внешнего

воздействия

с определенными

значениями,

характерными для

данной системы.



Главное положение АТР

• изменение размеров и формы воздушных полостей
речевого тракта

• изменение его резонансных свойств

• изменение тембра звучания

• Речевой сигнал возникает в результате воздействия
одного или нескольких источников звука на систему
резонаторов, образуемых воздушными полостями
речевого тракта.



P(f) = S(f) T(f)

давление(частота) = источник(частота) передача(частота)

амплитудно-частотный спектр результирующих
звуковых колебаний = амплитудно-частотный
спектр колебаний, создаваемых источником звука
передаточная функция резонаторной системы
речевого тракта (на той же частоте)

произнесение как динамический процесс >
параметр времени

P(f, t) = S(f, t) T(f, t)



Образование речевого сигнала 
при производстве гласных



Образование речевого сигнала 
при производстве гласных

АТР – модель «источник – фильтр» 
(англ. source-filter model)

• А – голосовой источник создает периодические толчки
воздуха

• Б – амплитуды гармоник спектра этих толчков
• В – амплитуды гармоник спектра этих толчков проходят

через резонаторную систему речевого тракта
• Г – и умножаются на значения передаточной функции,

которая имеет две выраженные резонансные частоты
• Д – в результате – сложный периодический сигнал,
• Е – в котором усилены спектральные составляющие, частоты

которых наиболее близки к резонансным максимумам
передаточной функции речевого тракта



Источники звука в речи

при производстве речевых звуков 

акустическая модуляция воздушного потока 

осуществляется тремя способами >

три типа источников звука:

• 1) голосовой

• 2) турбулентный

• 3) импульсный



Голосовой источник звука

голосовые связки > единственный источник в образовании

гласных и сонорных согласных

1) колебания голосовых связок > поток воздуха
превращается в последовательность воздушных толчков
(импульсов)

2) каждый голосовой импульс > звуковая волна в речевом
тракте

Последовательность воздушных толчков, возникающих в
результате колебания голосовых связок, – глоттальная
волна (голос).



Голос

сложный периодический звук
= сумма простых синусоидальных колебаний (гармоник)

1) 1-ая гармоника голосового спектра – основной тон:
• частота основного тона – это частота, обратная периоду

глоттальной волны (F0 = 1/T)
• частота основного тона = частота колебаний голосовых

связок

2) частоты остальных гармоник (обертонов)
– в целое число раз > ЧОТ (n F0, где n – номер гармоники)

F0 = 100 Гц > обертоны 200 Гц, 300 Гц, 400 Гц



НЕ строгая периодичность голосовых колебаний:

• 1) случайная вариативность периода последовательных
голосовых импульсов (джиттер-эффект, jitter ‘дрожание’)

• 2) случайная вариативность амплитуды (шиммер-эффект,
shimmer ‘мерцание’)

• < … эмоции, физиологическое состояние, интонация…



Основная частота F0 глоттальной волны (ЧОТ)

• определяет высоту голоса
чем > F0, тем выше голос

• изменяется: интонация, логические ударения и т.д.
- диапазон изменений – около 1,5-2 октав (октава –

отношение частот, равное двум)
- базовая (нейтральная) основная частота (modal F0)
1/3 или 1/4 голосового диапазона от нижней границы

< пол и возраст < степень упругости, длина и масса
голосовых связок
муж. – ср. 130 Гц (80-200 Гц)
жен. – ср. 260 Гц (150-400 Гц)
детск. – 200-500 Гц





Турбулентный источник звука

• турбулентный шум < в воздушном потоке,
проходящем по речевому тракту, появляется
турбулентность, обусловленная вихрями

• вихри:

- частицы воздуха двигаются по направлению
течения,

- но совершают сложные и беспорядочные
перемещения

(в т.ч. круговые)



Условия для возникновения турбулентного потока

• 1) на пути потока значительное сужение (щель)
• 2) позади сужения избыточное давление, чтобы поток

двигался через сужение со скоростью, необходимой для
образования турбулентности

фрикативные согласные
• глухие [с], [ш], [х], [ф] – артикуляция наиболее

благоприятна для формирования турбулентного шума
(голос. щель широко открыта, связки не колеблются,
подсвязочное давление)

• звонкие [з], [ж], [в] – голосовая щель периодически
закрывается > меньшее избыточное давление и меньшая
скорость потока

• сонорные ротовые согласные при полном или частичном
оглушении



Механизм возникновения турбулентности
• сжатый воздух проходит через сужение и приобретает

большую скорость
• поток превращается в высокоскоростную струю
• на выходе из сужения струя сталкивается с инертной

воздушной массой и разбивается на фрагменты,
содержащие вихри

• вихри смешиваются с остальной массой воздуха
• возникают быстрые и нерегулярные колебания

давления, которые воспринимаются как шум

• твёрдое препятствие > бОльшая турбулентность
свистящие и шипящие (сибилянтные) [с] и [ш]: воздуш.
струя после сужения направлена под прямым углом на
верхние или нижние зубы > самый интенсивный шум



Виды турбулентного шума

• 1) фрикативный (лат. frictio ‘трение’) – выше гортани
• 2) аспиративный (лат. aspiratio ‘дыхание’) – в гортанной

полости (через открытую и несколько суженную голосовую
щель – англ. [h]), небольшая амплитуда шума

• Амплитуда (и интенсивность) шума зависит от:
< размер сужения
< наличие препятствия
< пространственная ориентация препятствия
< различия в работе голосовых связок (глухие / звонкие
фрикативные)

Спектр турб. шума сплошной: нет отдельных гармоник;
плоская огибающая в частотном интервале 500-3000 Гц.



Турбулентный шумовой источник в речи



Импульсный источник звука
• Звуковой импульс (взрыв) – скачкообразное

изменение давления воздуха.

• значительное избыточное давление в речевом тракте:

- полностью перекрыт выход воздуха на достаточно
длительный интервал времени (не менее 30 мсек.)

- интервал полной смычки артикуляторов всегда перед
импульсным звуком

- быстрое размыкание смычки > резкое возрастание
воздушного потока на выходе > скачкообразное
изменение давления воздуха



Амплитуда импульсного звука

• глухие взрывные [п], [т], [к] (после них может быть турб. 
шум фрикативного или аспиративного типа)

• Амплитуда импульсного звука зависит от давления
воздуха позади смычки.

• Наиболее интенсивные взрывы согласных, место
образования которых ближе к гортани.

• Взрывы глухих интенсивнее взрывов звонких согласных.

• Интенсивность взрыва зависит от силы выдоха (величины
подсвязочного давления).

• Импульсный звук: сплошной спектр с плоской
огибающей, близкой к спектру белого шума.



Импульсный источник в речи



Тип источника 
с учетом комбинаторики

Класс звуков

голосовой гласные и сонорные согласные

турбулентный глухие фрикативные согласные

импульсный глухие взрывные согласные

импульсный + турбулентный
(фрикативный  и/или аспиративный, 

последовательно) 

глухие взрывные согласные и 
аффрикаты

голосовой + турбулентный
(одновременно)

звонкие фрикативные согласные

голосовой + импульсный
(сначала первый, затем 

одновременно) 

звонкие взрывные согласные

голосовой + импульсный + 
турбулентный

(сначала первый, затем 
последовательность остальных 

одновременно с первым)

звонкие взрывные согласные и 
аффрикаты



Форманта и антиформанта передаточной функции

• Воздушный столб в речевом тракте – сложная
колебательная система.

• Передаточная функция этой колебательной системы –
сложная резонансная кривая с амплитудными
максимумами на собственных (резонансных) частотах.

• Форманты – резонансные максимумы передаточной
функции. Они формируют фонетические различия между
звуками.

F1, F2, F3 (частоты формант)

Ширина форманты (англ. bandwidth ‘полоса частот’) –
определяется диапазоном частот по обе стороны от
частоты форманты, которые получают усиление, примерно
эквивалентное точному резонансному (В1, В2, В3).



Антирезонансы и антиформанты

• Антирезонансы речевого тракта (противоп. резонансам) –
резко ослабляют амплитуду составляющих с частотами,
близкими собственной частоте антирезонанса > глубокие
минимумы (до нулей) в передаточной функции или
сильное подавление близких резонансных частот.

• Антиформанты – антирезонансы, или нули передаточной
функции.

Z1, Z2, Z3



Классификация гласных



Влияние формы тракта на его резонансные свойства



Влияние формы тракта на его резонансные свойства
• 1) Увеличение общей длины тракта > понижение частоты

всех формант. Уменьшение общей длины тракта >
повышение частоты всех формант. (женская и детская
речь)

• 2) Огубление > понижение частоты всех формант.
• 3) Сужение в передней части ротовой полости ([i], язык

вперед и вверх) > резкое увеличение расстояния между F1 и
F2 (понижение F1 и повышение F2; F2 и F3 сближаются).

• 4) Сужение в задней части ротовой полости ([u], язык
назад и вверх + сужение в области губ) > сокращение
расстояния между F1 и F2 + их понижение; расстояние
между F2 и F3 максимально.

• 5) Сужение в фарингальной части ([а], язык назад) >
резкое сокращение расстояния между F1 и F2 (повышение
F1 и понижение F2).



• F1 – признак подъема

• F2 – признак ряда



Average vowel formants

Vowel
(IPA)

Formant F1
(Hz)

Formant F2
(Hz)

a 850 1610

e 390 2300

i 240 2400

o 360 640

u 250 595

y 235 2100

ø 370 1900

œ 585 1710

ɑ 750 940

ɒ 700 760

ɔ 500 700

ɛ 610 1900

ɤ 460 1310

ɯ 300 1390

ɶ 820 1530

ʌ 600 1170



Методы и средства акустического анализа речи

• Осциллограмма (лат. oscillum ‘колебание’ + -грамма
‘запись’): изменение амплитуды звукового давления во
времени при произнесении речевого отрезка.





• Спектрограмма (лат. spectrum ‘видимое’ + -
грамма ‘запись’): графическое изображение
спектра звуковых колебаний (относительная
амплитуда и интенсивность, распределение общей
энергии звукового колебания по частотам).



Акустические характеристики звуков

различия между звуками

• < тип источника звука

• < характеристики резонаторной системы речевого 
тракта

• фонетическая сегментация сигнала

• акустические свойства звука

• < собственные артикуляционные признаки

• < фонетический контекст (соседние звуки,
ударение, интонация)



Фонетическая сегментация речевого сигнала

Самые сложные для сегментации сигналы –
последовательности гласных и сочетания гласных с
неносовыми сонорными согласными (большая
пограничная зона, а не четкая граница) > значительная
степень условности при выборе границы.



Зависимость акустических характеристик звуков 
от контекста

• Коартикуляция

– артикуляционное взаимодействие между звуками.

• Артикуляционная редукция

– недостижение речевыми органами целевого
состояния, требуемого звуком.



> акустические следствия:

1) не всегда можно выделить стационарный участок
(соответствующий артикуляционной выдержке) – с
устойчивыми и мало изменяющимися спектральными
характеристиками; недостижение целевого акустического
эффекта и изменения в слуховом качестве звука

2) cтационарный участок звука < артикуляционные
признаки соседних звуков

3) переходные артикуляционные состояния > переходные
участки с быстро меняющейся спектральной картиной



согласный + гласный и гласный + согласный

• коартикуляция > формантные переходы на начальных и 
конечных участках гласных

Спектр согласных: низкочастотная часть
формантной картины (F-картины) согласных (F1 и F2)
отсутствует или сильно подавлена.

Форманты соседних гласных и следы этих формант в
спектре согласного > скрытые формантные локусы
согласных.



Акустические характеристики гласных

• голосовой источник > периодичность звуковой волны и
гармоническая структура спектра

• Частота F1 обратно пропорциональна подъему гласного:
чем выше подъем и больше закрытость гласного, тем
меньше F1, и наоборот.

• Частота F2 прямо пропорциональна продвинутости
языка (ряду гласного): чем более передний гласный, тем
больше F2, и наоборот.

[a]: F1 >, F2 <.

[i]: F1 <, F2 >.

• Огубление понижает F1 и F2, особенно F2.



Признаки согласных, влияющие на соседние гласные

• дополнительные артикуляции: 

- палатализация 

- веляризация

• коартикуляционные эффекты 

– особенно на динамике F2



Изменение F1 и F2 русских гласных после разных согласных











Акустические характеристики 
шумных взрывных согласных

• динамически сложная артикуляция:
1) смычка
2) шумовой отрезок 

Акустические характеристики интервала смычки
• стоп-пауза (не отделяется от молчания в начале фразы)
• нереализованный шумовой интервал
• вокальные периоды на смычке глухого в интервокале

(частичное озвончение)
• звонкие смычные – голосовая полоса (звонкая пауза) –

малая интенсивность
• длительность смычки – 30-120 мсек. (0,03-0,12 сек.)

> у глухих



Акустические характеристики шумового интервала

• малое избыточное давление позади смычки > отсутствие 
шумового интервала (у звонких типа [б])

• неоднородность: взрыв + шум фрикации 

(+ аспиративный 

шум)



[т] / аффрицир. [т’]

• взрыв – узкая 
вертикальная линия

смычка раскрывается
медленно > взрывная фаза смазана или отсутствует

(акустическая картина шума взрывных сближается с 
аффрикатами)

аффрицированные – взрывные согласные, у которых
шумовой участок содержит выраженный и длительный
участок фрикативного шума (палатализованные
переднеязычные взрывные)



• аспирированные – взрывные согласные, при
произнесении которых аспиративный шум
существенно превышает по длительности шум
фрикации

глухие взрывные согласные англ. яз.
перед ударными гласными

голосовая щель в момент размыкания
смычки широко раскрыта



• Неоднородность шумового интервала взрывных
согласных:

- длительность шума

- интенсивность шума

- спектр шума

1) простые взрывные: 40-60 мсек. – шумовая фаза,
длительность взрыва – 3-5 мсек.

2) аффрицированные и аспирированные взрывные:
100-120 мсек. – шумовая фаза

3) длительность шумовой фазы < место образования,
глухость / звонкость

[б] / [k(h)]

4) интенсивность взрывной фазы и шумового
интервала < место образования, глухость / звонкость























Локусная F-картина взрывных согласных

• формантные переходы (< перестройка артикуляторов и
изменения в речевом тракте) – 40-50 мсек.



Локус F2 для альвеолярного согласного [d] перед V



Локусы согласных

• локус F1 – отражает смычность согласного

(степень сужения речевого тракта; max – у взрывных)

• локус F2 (локус F3) – место образования преграды
(губные – самый низкий локус F2)

• велярные согласные – самая большая область
возможных локусов (1000-2500 Гц)



Акустические характеристики 
фрикативных согласных

• однородная артикуляция > более простые акустические
свойства

• турбулентный ист. зв. / турб. + голос. ист. зв.

• шумовая полоса – вертикальная штриховка

нерегулярные свойства шума – глухие

амплитудная модуляция шума – звонкие

• бОльшая длительность и интенсивность шума у глухих

(min – губные звонкие [в], max – сибилянты [с] и [ш])

• длительность фрикативных – 50-200 мсек.

(< фонетический контекст)



Глухие фрикативные согласные 
в интервокальном контексте



















Акустические характеристики аффрикат

• промежуточное положение между взрывными и
фрикативными (по акустическим свойствам)

• интервал смычки
глухие – стоп-пауза
звонкие – голосовая полоса

• турбулентный шум

• длительность смычки <, чем у взрывных
• длительность шума >, чем у взрывных (но <, чем у

фрикативных)









Акустические характеристики сонорных согласных
Акустические характеристики носовых сонорных

• участие носовой полости > дополнительные
форманты в спектре

• самая низкая форманта – форманта назализации (200-
300 Гц) – интенсивна в спектре

• усиление низких гармоник голосового источника

• подавление ротовых формант

• по сравнению с гласными – довольно низкая
интенсивность

















Акустические характеристики 
неносовых сонорных согласных

• голосовой источник

• небольшое сужение (воздух проходит относительно
свободно, без образования шума)

• проход в носовую полость закрыт

• > 1) периодичность сигнала

2) голосовая полоса и вертикальная штриховка

3) отчетливая формантная картина



Центральные аппроксиманты

• рус. [й], англ. [j], [w]

• полугласные (semivowels)

• воздух свободно проходит по центру ротовой полости

• артикуляционное сужение больше, чем у гласных

> понижение F1 (< 300 Гц; min - у огубл. [w])

> потеря энергии звуковых колебаний голосового
источника (F2, F3)

> уменьшение общей интенсивности

• локусная F-картина ~ F-картине гласных, ближайших по
артикуляции ([i], [u]…)

• плавный переход в форманты соседних гласных
(длительный переходный участок: глайды < glide
‘скольжение’)













Боковые (латеральные) сонорные 

• рус. [л], англ. [l]
• преграда – кончик языка и верхние зубы (альвеолы)
• проход для воздушного потока – вдоль боковых сторон

языка
• образование суженных проходов в передней части ротовой

полости + общее удлинение тракта >
> понижение F1
> ослабление F2 и F3
> антирезонанс (в области 2000-2500 Гц) –

подавляет F3 и ослабляет F2 (видимые max спектра F2 –
F4)

F2 хорошо видна



F-картина боковых (латеральных) сонорных
(средние значения) 

• F1 ~ 300 Гц

• F2 ~ 800-1200 Гц

• F3 ~ 2500-3000 Гц

• меньшая длительность и бОльшая скорость
формантных переходов с гласными

- уменьшение общей интенсивности сигнала

- ослабление главных ротовых формант на
боковом согласном

- размыкание язычной преграды > небольшой
взрыв





Дрожащие согласные (вибранты)

• колебания активного артикулятора в воздушном потоке 
рус. [р]

• количество колебаний (ударов) – одноударный, 2-3 удара 
• понижение F1, уменьшение уровня всех вышележащих

формант
• закрытая фаза (сужение прохода) ~ смычка звонкого

взрывного (очень короткая, нет взрыва после нее)
• F-картина среднеязычного вибранта:

F1 ~ 500-600 Гц
F2 ~ 1300-1600 Гц
F3 ~ 1800-2300 Гц

• плавный формантный переход с гласными



Многоударный и одноударный варианты рус. [р]
в интервокальной позиции
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Praat
Doing Phonetics by Computer

• Вся актуальная информация о программе Praat на сайте + 
возможность скачать программу: 

http://praat.org/
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• запись аудиофайла (Record)
• анализ аудиофайлов

• осциллограммы (Waveforms)
• спектрограммы (Spectrograms) разных типов

• измерение длительности сегментов (Duration)
• определение времени начала озвончения смычных (Voice Onset 

Time, VOT)
• изучение и измерение частоты основного тона (Pitch, F0)
• изучение голосовых импульсов (Pulses), эффектов «джиттер» и

«шиммер» (Jitter, Shimmer), коэффициента «гармонический
звук – шум» (Harmonics-to-noise ratio)

• изучение и измерение формант (Formants)
• измерение интенсивности (Intensity)
• работа со спектральным срезом (Spectral slice)
• измерение амплитуды и частоты периодических колебаний

(Harmonic Amplitude, Frequency)
• изучение фонации (скрипучий и придыхательный голос;

Creakiness and Breathiness using Spectral Tilt)
• изучение назализации (Nasality)…



• создание аудиофайлов с заданными характеристиками

• обрезка, копирование, соединение и вставка звуковых
фрагментов

• изменение частоты дискретизации (Sampling Rates and
Resampling)

• применение фильтров к аудиофайлам

• изменение параметров частоты основного тона,
длительности, интенсивности (для перцептивных
экспериментов)

• построение графиков, создание иллюстраций для статей
(Plots) – Praat Picture Window

• разметка и аннотирование звуковых сегментов (Annotate,
TextGrids)

• написание и применение скриптов для автоматизации
анализа



Окна программы Praat

• При открытии два окна:

• окно Praat Objects

- для открытия

- для создания

- для сохранения

аудиофайлов



окно Praat Objects

при открытии 

звукового файла



View & Edit (Просмотр и редактирование) > 
Editor Window (окно редактирования)



Окно Info Window: 
информация, результаты измерений, данные



Второе окно 
при открытии:

• окно Praat Picture



Recording Sounds / Запись аудиофайлов

• включить микрофон

• Objects > New > 

Record mono Sound



Recording Sounds / Запись аудиофайлов
Окно Sound Recorder (Запись аудиофайлов)

• 44 100 Hz (Гц)

• Record / Запись

• Stop / Стоп

• Name > Save to list

Назвать > Сохранить



Opening Files / Открыть аудиофайл

• Подходят форматы:

• .aiff

• .wav

• .flac

• НЕ подходят форматы:

• .wma, (.mp3), .m4a

• Objects > Open > Read from File…

• Ctrl + O



Работа с длинными (долгими) аудиофайлами

• Objects > Open > Open long sound  file…

• Нарезать длинные аудиофайлы на короткие можно в 
программе:

Audacity http://audacity.sourceforge.net/



Saving files / Сохранение аудиофайлов

Objects > Save > Save as ______ file

Иначе при закрытии Praatа изменения не сохранятся!

1) Звуковые файлы сохраняем как Save as WAV file.

2) Другие файлы (разметки TextGrids, formant objects, pitch
objects…) сохраняем как Save as text file.

3) Звук + разметка – можно сохранить как Save as binary file 
(PraatCollection).



Phonetic Measurement and Analysis in Praat
Фонетический анализ в программе Praat

Работа с осциллограммами (waveforms) и 
спектрограммами (spectrograms)

1) загрузить аудиофайл в окно Praat Objects
2) выделить его (синим)
3) Objects > View & Edit

Желтая линия – интенсивность (дБ) / Intensity
Голубая линия – частота основного тона, ЧОТ (Гц) / Pitch
Красные точки – форманты / Formants

Чтобы прослушать звук – нажать на серое поле Total
Duration.



Приближение и отдаление

• Editor Window > View > Zoom (приближение и отдаление)

• или комбинации клавиш на клавиатуре

• Одни и те же настройки для нескольких одновременно
открытых файлов.



Pulling out a smaller section of the file for analysis
Вычленение отдельного звукового отрезка для анализа

• Editor > File > Extract Selected Sound (time from 0)

• Этот звуковой отрезок будет доступен как отдельный файл 
в окне Praat Objects.



Spectrogram Settings / Настройки спектрограмм

• 0-5000 Гц (Hz)

• Editor > Spectrum > Spectrogram Settings



View Range

• Для изучения акустики речи обычно – от 0 до 5000-
6000 Гц.

• НО: для детального изучения фрикативных согласных 
– до 15 000 Гц.

• Для изучения музыкальной акустики – 100-2000 Гц.

• Dynamic Range

• спектрограммы слишком темные или слишком светлые

• обычно 50 дБ – достаточно для многих целей

• подбор на практике



Narrowband spectrogram / 
Узкополосные спектрограммы

• гармоники и ЧОТ (F0)

• “small window, bad frequency, good timing”

• 1. Editor > Spectrum > Spectrogram Settings

• 2. Установите Window Length 0.025 (или на выбор)

• 3. Нажмите OK



Broadband spectrogram / 
Широкополосные спектрограммы

• темпоральные характеристики звука и форманты гласных

• “wide window, good frequency, bad timing”

• 1. Editor > Spectrum > Spectrogram Settings

• 2. Установите Window Length 0.005 (или на выбор)

• 3. Нажмите OK



Измерение длительности звуковых отрезков 

• выделить нужный звуковой отрезок

• Editor > Query > Get selection length

• или посмотреть длительность внизу на сером поле

• 0,01… сек. = 10 мсек.

• 0,1… сек. = 100 мсек.

• 0,001 сек. = 1 мсек. 

• Total duration

• Visible Part



Измерение F0 / Pitch (частоты основного тона, ЧОТ)

• Editor > Pitch > Show Pitch

• отображается как голубая горизонтальная линия

• измеряется в Гц (герцах)

• Editor > Pitch > Get Pitch (средняя ЧОТ)

• Max

• Min 



Настройки параметров ЧОТ (Pitch Settings)

• Editor > Pitch > Pitch Settings…

• Pitch Range: 50-400 Гц для общих целей.

• Для песен и детской речи – выше.

• < базовая (нейтральная) частота основного тона
конкретного носителя языка

• Unit: единица измерения (Гц, мел…).

• Analysis Method



Измерение Pulses, Jitter, Shimmer
and Harmonics-to-noise ratio

• Editor > Pulses > Show Pulses

• Голубые вертикальные линии



Sound Help > Manual > Search > Symbols


